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Introduction 

There are some design issues to consider with forms. First, if you create the forms using 

Microsoft Word, you cannot use the Form Controls in Word or other native applications. 

You must use the Form Controls in Adobe Acrobat Pro DC. 

Note: If you choose to use LiveCycle Designer aka Form Designer to 

create forms you should know that you need to create the entire form in 

Form Designer in order to optimize accessibility. Using an untagged 

document as the template will result in any instructions or information 

on that template not being tagged.  

The next chapter in this book details the creation of forms using Form Designer. Form 

Designer now has a built-in accessibility checker! 

Using Adobe Acrobat and its tools for automatic field generation , a simple form works best. 

That is a form with text fields only. Once you have list boxes, Radio Buttons or Check Boxes, 

the auto-detect tools in Acrobat may not find them and create them. The tool is not that 

sophisticated. However, for text fields it works quite well. You will need to add the 

Dropdown list boxes, Radio Buttons and Check Boxes manually.  

One of the “quirks” of PDF fillable forms is that when you use the Tab key to move from 

form control to form control you may encounter a repetitive Tab at the end of the page. 

This is normal and has been repeatedly logged as a bug. The extra Tab is not present if 

someone uses their screen reader to get a list of form controls. Those of us who do use 

adaptive technology or the keyboard to navigate form controls are used to this hiccup/bug. 

Adobe is aware of this problem. 
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Note: You will have to save documents, close them and open them again 

for a screen reader to “see” the repairs. You MUST start the screen reader 

BEFORE you launch the application which might require you to exit 

Acrobat, start the screen reader then launch Acrobat and the document 

again. 

When using a Word or Excel document as the foundation for a form, use the Print tools in 

the File/Backstage area and choose Adobe PDF as the printer.  In the case of using Excel as 

a form template, you will want to select the range to print so that the entire worksheet is 

not printed to Adobe PDF. 

Do not create a tagged document as the starting point for a PDF form!   

Do not “Tag as you go” when creating an accessible PDF form! 

 

Figure 1 Print to Adobe PDF printer option in Word. 

If we go back to our hierarchy of tasks we find that adding form controls comes before we 

add Tags to the document. 

1. Is the document a scanned image? 

a. If yes, use the Adobe Acrobat OCR tool to make it readable text. 
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2. Does the document have links? 

a. If yes, use Document Processing, Create links from URL’s to identify them. 

3. Does the document have form controls? 

a. If yes, add the form controls. 

4. Does the PDF document contain multimedia? 

a. If yes, add the multimedia. 

Once these questions have been answered and the tasks performed add the Tags to the 

document. 

Note: Creating forms is a mouse dependent activity. You will also have 

difficulty creating forms if you are using a screen reader.  This is because 

screen readers (and Text-to-Speech tools) are always in virtual view of 

the document and you may find yourself taking more time than 

necessary to try and anchor the form control. 

Screen Readers and Forms 
Before we begin creating forms and making them accessible, it is worth taking some time to 

understand how those of us who use either screen readers or TTS tools access forms. 

As previously mentioned in this book, there is a misconception that those of us who use 

adaptive technology “Tab” through all types of content in any type of document. 

This is NOT true. 

We Tab through form controls (fields) and links. 

For all other content, other than tables, we use standard navigation and reading 

commands. Even within a text form control we can use standard keyboard commands (or 

should be able to) to review and revise our work. With tables, there are specific table 

navigation commands that facilitate the ability to get more granular information and/or 

specific information for a specific cell. In some applications using the Tab and Shift + Tab 

within a table lets us move from cell to cell and then we have the ability to query the cell for 

specific information and information on the relationship between the cell data and 

surrounding data. 
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When encountering a form control, our adaptive technology switches to forms mode and 

most will also notify us that we are in a form control by providing some type of sound, like 

a ding. 

If there are instructions in a form, we have access to the instructions IF the form is tagged. 

When a PDF form opens while a screen reader is running, we get a summary of the 

document including how many links and headings are in the document. At this point, we 

can choose to either listen to the preamble and instructions, if any, before the first form 

control, or we can press Tab to move to the first form control and begin filling in the form. 

Another option we have is to list the form controls to get an idea of the number of form 

controls and what types of information is being asked for. At that point we can choose to go 

back and read instructions or choose the first form control, press Enter and begin filling in 

the form. 

Those of us who use adaptive technology with PDF forms are just like everyone else, we 

often just start filling in the form and only read instructions when we have to. 

Part of any Quality Assurance done on PDF forms begins with an understanding of how 

those of us who use adaptive technology access content. In a PDF form we can use headings 

to move to specific topics/areas of the form and use standard keyboard commands to then 

either move to the first form control under that heading or read any preamble instructions 

for that first form control in the section. 

If we use the up and Down arrows to move line by line, we hear a sound when entering a 

form control and our screen readers will announce forms mode on. When we exit a form 

control, we hear a sound and our screen readers announce forms mode off. 

It gets a bit complicated when our screen readers suddenly bounce us out of forms mode in 

a text entry control when we are trying to review and edit what we’ve written but this is 

more of a screen reader bug than a bug with the text form control in the PDF form. If you 

are using a screen reader, you may notice this happening with list or combo form controls 

as well. 

It is easy to then acknowledge how important ToolTips are for someone accessing a PDF 

form using adaptive technology. Of equal importance is the design of the form. 

Hands up if you think about the design of a form before you begin creating your template! 
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Form Design Best Practices 

When creating a template for a form using Word or any other application, do not use the 

symbols for Check Boxes or Radio Buttons and do not add form controls available in the 

application. For example, using Word’s Content Controls or ActiveX controls does not 

create a form that transfers gracefully to a PDF form. 

Note: Even in Word, Content Controls are NOT accessible.  

One of the first things to look at when thinking of designing a form is the logical order of 

the form controls on the page.  Another is the visual limitations you put on yourself by 

choosing to use a table for design layout. Most people do not use tables for form design 

effectively. There are many scenarios where not putting a form in a table gives you greater 

flexibility in form design. Do NOT use Excel to design forms! 

In the following image the form control for the apartment number is positioned AFTER all 

of the other address information is entered. As someone who does live in an apartment 

comes to fill in this information, the implication is that if they have an apartment number it 

would go into the general address field. Only after entering the other information would 

they discover that they had to enter the apartment number separately. They then either 

leave it as is or go back to the address field and delete the apartment number and add it in 

the apartment number field. This takes time, is frustrating and for those with visual, 

learning or cognitive disabilities can be a barrier to understanding what information is 

needed. 
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Figure 2 Illogical order of information requested. 

In the following image there are two problems with the design of the form/questions. First, 

there is no format identified for the birth date and second, the gender and returning 

participant information would be a Text form control rather than Radio Buttons based on 

the format of the question. 

Instead of Sex (M/F) it should be Sex:   Male   Female 

This would allow for the Radio Buttons to be placed either before or after the text Male or 

Female.  

This brings up another important best practice. Make sure that when you design a form 

that you are consistent in where Radio Buttons and Check Boxes are place. In fact, where all 

form controls are placed. If you set up a question where the form controls follow the 

label/Caption (question) then that is the format you use throughout the entire form 

including questions using Radio Buttons and Check Boxes. Randomly putting form controls 

before or after the label/Caption causes confusion for everyone, not just those of us with 

disabilities. 

 

Figure 3 Poor practice for arranging Radio Button based content on a form. 

An example of how not to lay out information related to birth date is shown in the following 

image. The form this example was taken from was created using Excel (just say NO!) but 

the example could easily have come from Word. 
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Figure 4 Poorly laid out birth date area of a form. 

First, the simple and easily understood way of laying out this type of information request is 

to simply say “Birth date (YY-MM-DD” which gives the person filling in the form the format 

of the date required.) In Adobe Acrobat Pro DC you can format a form control to accept a 

specific date format which we’ll cover later in this chapter. This would take up less space 

on the form than the preceding use of three rows and six cells of a table. 

The second problem with this approach is that for the year form control, only one character 

is representing  the year as per the single “Y.” Does this mean that one should enter 2016, 

16 or simply 6 and hope That the people gathering information from the form understand 

what you meant. 

 

Figure 5 Poor contrast identifying date format. 

The preceding image illustrates another aspect of poor form design. Believe it or not there 

are faint letters in the date area that indicate the format is to be MM/YY. Using this type of 

technique to show how a date is to be entered creates two barriers: the text is almost 

invisible and in making the text more visible, the text becomes a visual barrier to seeing 

what you type into the field. 

Ambiguity of information requested is one of the largest barriers to good form design and 

being able to quickly fill out forms that I’ve come across. The second common mistake in 

designing forms is in the consistency of information requested. 

Consider a form where on the first page, the person’s name is structured as last name then 

first name, on the second page it is all one text form control, and on the third page it is back 

to being two form controls but on page three the order is first name and then last name. 
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We often expect that once a pattern is established, that pattern will hold for the rest of the 

document. Those of us with disabilities who use adaptive technology depend on 

consistency to quickly move through and understand digital content. 

We expect that if we are to provide details for a specific piece of information that we have 

enough room on the form to provide that information. Consider the following example that 

was taken from an actual form. 

 

Figure 6 Poorly designed two part answer form. 

In the preceding image, the words vision loss are in cell A2 with a shape representing a 

check box in B2 and cells C2  and D2 have an underline where you are supposed to write an 

more details about your vision loss. However, the details can only fit in the two cell width. 

The person who designed the form did not leave room for the answer. They were focused 

on using a table to lay out the form, using shapes for Check Boxes  and the amount of 

“space” that would be equal to a printed page. 

Another problem with using symbols and shapes often found in form templates is one 

illustrated in both the preceding and following images. 

 

Figure 7 Symbols used in a single table cell to identify Check Boxes. 

The problem with the preceding form example is that the area of the form where Radio 

Buttons should go does not allow enough room to add Radio Buttons. In Adobe acrobat you 

can make form controls only so small before they will not resize smaller. Additionally, if the 

form controls are too small, people with visual and  mobility disabilities or who have 
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unsteady hands will not be able to target them to provide an answer. These are people who 

may or may not use adaptive technology to steady their hands. This example is from an 

actual form template created in Excel. Also notice that when magnified, the font is pixelated 

and barely readable. 

The following illustration takes this technique a step further with a total of 10 symbols and 

corresponding text for Check Boxes contained in one cell. This is an example from a table 

used in Word to create the form template. 

 

Figure 8 Poor form design using symbols in a table cell. 

Another mistake often made in designing forms, especially when tables are used for design 

layout, is not leaving enough room for someone to answer the question. Once again, focus is 

on the confines of the table cells and the page and not on looking at what information the 

question is asking for. 

 

Figure 9 Poorly designed form with no space for answer. 

The preceding image shows a question where an applicant is supposed to write about their 

experience but has only a few characters to do so. Sometimes I’ve seen this type of layout 

with a caveat that the answer must b 1,000 words without leaving enough space for 1,000. 

Words in the form. 

Another problematic design is often found for contact information. 

 

Figure 10 Not enough space for form control. 



 

14 

 

The preceding image does not allow enough space within the row to add a moderately 

sized form control. As with not allowing enough space for Check Boxes and Radio Buttons, 

these types of form controls become difficult to target and answer. 

With digital forms, you don’t have to cram everything on one page. Think about the 

information you are asking for and give the question enough space on the page so that a 

form control can be added and that it represents the size of the answer/the space an 

answer will require.  You can adjust the height of rows in a table! Although where ever 

possible, I recommend NOT using a table for design layout of a form or any other type of 

document. 

 

Figure 11 Row height adjusted to fit the form control. 

Note: The last four forms I’ve worked on that use tables for design 

layout have not tagged correctly in Acrobat. In the case of two forms, 

only the <Form> Tags appeared in the Tags Tree after tagging. The 

remainder of the text on the page had to be tagged manually. On the 

other hand, the good news was that the <Form> Tags were there! 

This brings us to the overall use of tables for design layout…AGAIN. Just say NO! 

Recently I’ve seen more general information and form instructions laid out in tables, in 

both Excel and Word (Did I say Just Say NO!). Typically a page in a form will look like the 

layout in the following image. 
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Figure 12 Instructional text in a table. 

First, this is just bad design. Everything on this page could be accomplished using Headings 

and a paragraph style that features a paragraph border. This would then be more 

accessible in that those of us using screen readers or Text-to-Speech tools wouldn’t have to 

use table reading and navigation commands to read instructional text. 

When this is converted to tagged PDF AFTER the links and form controls are added, there 

are no <P> Tags, no <L>, <LI> or <LBody> Tags, only <Table>, <TR>, <TH> and <TD> Tags. 

In one form sent to me for analysis, the entire contents of four pages of a form were in a 

single <TD> cell and the <For>m Tags were not present. The entire four pages were one 

huge glob of “stuff.” Without the <Form>Tags in the Tags Tree, this form could not be 

remediated. 

For the preceding image, this page will have to be remediated manually to make sure that 

the Tags are correct for the content. I recommend removing the <Table> structure 
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completely and making the text more readable and representative of the true nature of the 

structure elements on the visual representation of the page. 

The scenario is worse if the form was designed in Excel where the differentiation between 

paragraphs is less obvious. However, the same labour intensive remediations are required. 

 

Figure 13 Instructional text formatted in Excel. 

We often see this same type of lack of design consideration with phone numbers. Consider 

the following format for a phone number: 

 

Figure 14 Oddly formatted phone number question. 

How many form controls should you add? Are the parentheses for the area code? Are the 

underlined spaces broken by the backslashes supposed to divide the rest of the phone 
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number into individual form controls? If someone starts typing into a form control added 

over this format, will they become visually confused? 

A better approach is to simply use text such as: 

Phone number including area code (555-555-1234) 

This gives someone the format that you want the phone number in. You can include dashes 

between the numbers, or periods or specify that you want the phone number to be one long 

string of numbers. This information is also added to the ToolTip. The information 

requested and how that information is to be entered becomes clear. 

While we are talking about using the Underline to mark where someone should write on a 

form, let’s look at one of the remediation consequences of this practice. 

The following image is of a form from the perspective of the Tags Tree. 

 

Figure 15 Underline as part of a paragraph in the Tags Tree. 

This needs to be remediated in the Content Panel. If left as is, adaptive technology will read 

the underline which may confuse the person filling out the form or reading through the 

form to get an idea of what information they need. It is also likely to show up in an 

Accessibility check of the document which will require it to be remediated. While adaptive 

technology does tend to shorten long lines of underline, Dot Leaders or dashes to only 

speaking three, in the image above, this may be distorted as there are a lot of underlines.  

To perform the remediation, go into the Control Panel and locate the Underline that is 

mistagged as a <P> or Paragraph. Press the AppKey or use the right mouse button to open 

the context menu and choose Create Artifact. Make sure that you only select the Underline 

pieces and not the text associated with the Underline. 
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Figure 16 Underline as a paragraph in the Content Panel. 

It is not uncommon to find the Underline nested under text in the Content Panel.  Save the 

document before and after you make the Underline an Artifact. Check in the Tags Tree to 

make sure that the text of the form is still the way it should be. Perform an Accessibility Full 

Check to see if anything has been affected by this remediation. 

This is another reason not to use Underline or symbols as placeholders in forms! They 

create more work than they save! 

As mentioned previously in this chapter, using symbols for form controls confuses those of 

us with visual, learning or cognitive disabilities as we attempt repeatedly to click on them 

and those of us using screen readers will hear “graphic” – yes they can be converted as 

graphics that you will need to add alt Text for. Using symbols as place markers for where 

you want form controls to go will also create problems in lining up the accessible form 

controls in Acrobat with the symbols in the document. 
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Figure 17 Check Boxes with an image of a Check Box to the left of them. 

It will be easier to use the Tab key to indent the text one Tab Stop on the line and leave the 

beginning of the line “empty.” This is illustrated in the following image. 

 

Figure 18 Check Boxes with indent and no symbol or image of Check Boxes to the left. 

This is true when creating Radio Buttons as well. 

The following image is another example of why we shouldn’t use symbols as visual place 

markers for form controls. 
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Figure 19 Visual representation of Check Boxes that really should be Radio Buttons. 

The scenario was taken from an actual form for a community day camp. Participants for the 

camp would be picked up at a specific bus stop near their homes so needed the bus top 

needed to  choose from a list that was arranged in two columns. 

As someone who didn’t develop the form template, one might begin putting Check Boxes in 

the form and then realize that they really should be Radio Buttons. The problem now is 

how to reconcile the squares for Check Boxes with the circles you will add for Radio 

Buttons. The following image shows the finished form area with the Radio Buttons. 

 

Figure 20 Radio Buttons for bus stop question in PDF form. 
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Another “confusing” form design happens when simple answers are required. Typically 

when you ask for gender information, the options are Male or Female and there is room to 

add the Radio Buttons. After all, with this question of two choices, only one choice is valid. 

It would be the same if you asked respondents to tell you if they had been to one of your 

previous webinars or training sessions; the answer is Yes or No. 

What form control would you use for the following form design? 

 

Figure 21 Confusing questions with single choice answer. 

The (Y/N) is part of the question but leaves no room for an answer. The (M/F) is also 

included in the question but has no supportive text for an answer. You can’t use Radio 

Buttons because there is no text to indicate to those NOT using adaptive technology which 

Radio Button is for Yes, which for No, which for Male or which for Female. 

In this case, the appropriate form control is a Text form control with a limit of one 

character. This must be made clear in the ToolTip. The ToolTip for this type of question 

might be: 

 “Gender, type M for Male or F for Female.” 

 “Have you previously attended one of our webinars, type N for No or Y for Yes.” 

It is another good reason why we need to think of the design of our forms before we start 

arranging questions on a page. 

If we think of adding information such as an address or multiline content, we begin to see 

that using a line across the page may not be the best idea. 

The following example is of an area of a form asking for comments. While identifying lines 

might have once been helpful as we transitioned to digital forms, it is the rare person who 

does not fill out a form online or on their computer in 2016. This goes back to the design of 

the form: is the form intended to be filled out online or printed out and filled in by hand? 

Even if it is to be filled out by hand, there is a tool in the Prepare Form tools to place a 
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visible rectangle around a form control which will better identify it to someone printing out 

and signing a form. 

 

Figure 22 Lines inserted into signature area of a document. 

If we consider a multiline text form control, often we see either the line method or tables 

used to provide writing guides for forms that are to be printed and filled out. 

 

Figure 23 Multiline form control using a table to provide writing guides. 

A variation on this is to only show the lines where someone would write, not the outline 

lines of the table. 
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Figure 24 Table used as writing guide with outline borders turned off. 

When this type of multiline text form control is opened in Acrobat and the automatic form 

control detection is used, there is a problem created. In fact, using this tool creates more 

work than it saves in the case of a form with formatting of writing guides for multiline text 

form controls. 

 

Figure 25 Multiline text form control in Acrobat after using the auto form detect tool. 

Here is the problem. 

When someone gets to the end of the line in the first “line” of the writing guide, they have to 

retain their thought, press the Tab key and listen to the ToolTip to verify that they are in 

the next line they can type in and still in the area of the form where they are asked to 

comment. For anyone with a visual, learning or cognitive disabilities, and I would add 
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anyone without a disability, it becomes difficult to retain the thoughts you may have had as 

a coherent comment. 

Another barrier created by the use of guiding lines for writing is the inability to allow 

sufficient lines for the amount of content you are asking for. For example, if you ask 

someone for a 500 word abstract, you have to provide enough lines to accommodate 500 

words for people whose writing might be small or large or who might print rather than 

write. 

The solution is to remove all but one of the text form controls and then expand that text 

form control, making sure that in the text form control properties, multiline is chosen. 

This allows for fluid thought and writing of comments or any other text expressions asked 

for. Additionally, by using the multi-line attribute, form designer can assign a specific 

amount of space on the form for the response without having to try and calculate for 

handwriting, printing, or handwriting characteristics. 

 

Figure 26 One text form control to add comments as a multiline text entry. 

Can you see the new problem? 

You will have to make the font size match the spacing for the writing guides or someone 

with a visual, learning or cognitive disability will be writing over the writing guides making 

proofreading and revising their answer almost impossible. Visually, you’ve created a 

barrier to filling out the form. 

What is the best way to represent this in a form? 

The best practice is to fix any potential barriers to accessibility in the design of the form. In 

the case of multiline text entry areas, this means not trying to be helpful by providing the 
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writing guides. Provide one text writing area when you add the form control in Adobe 

Acrobat with the multiline option checked in the properties of the form control. 

 

Figure 27 Accessible multiline text form control. 

In designing a form you need to consider all the types of form controls you will add to the 

document and what formatting you will want for each form control. 

For example, if you want someone to enter a date, what format do you want the date to be 

in? “yy-mm-dd” or yyyy/mm/dd.” You can set this in Adobe Acrobat but you need to let 

people know which format to type the date if you do. This information must also appear in 

the ToolTip for those filling out the form using adaptive technology. 

Another consideration that is often overlooked is a zip/postal code for forms that are to be 

filled out by people in both the Canada and the United States. Often a limit is placed on the 

zip/postal code of 5 characters which do represent the average zip code in the US. 

However, in Canada we have two groups of 3 characters separated by a space. In some 

areas of the US there are dual postal codes that have more than 5 characters. This has to be 

considered when creating the form and then adding the form control. If you have text in the 

form that asks for a zip/postal code, you need to follow that up with a form control that can 

handle all types of zip codes and the Canadian postal code syntax. 

It is easier to keep the form design simple and add the cosmetic elements of a form in 

Adobe Acrobat Pro DC. 
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What Can Go Wrong? 
The following image demonstrates what can go wrong for no good reason when you are 

creating a form. The form was created using a template created in Word. The table used for 

design layout for the form was a regular simple table. 

When the Word document was tagged from Word, the table was created correctly. I did this 

as a test once I saw the results of tagging in Adobe Acrobat. You never start a form with a 

tagged PDF. In this case I wanted to examine the tagging from Word to try and find out 

where the tagging process went wrong. 

I didn’t have access to the PDF at the point where the form controls had been added but the 

document had not been tagged yet. 

The next test I did was to use the Print to Adobe PDF tool from Word. I wanted to see if the 

results were the same if I didn’t have the form controls in the document. 

They weren’t. The document tagged although the text for the table was tagged as individual 

paragraphs instead of in a table. 

So tagging from Word resulted in a comparable version of the Word document in PDF but 

tagging an untagged version of the document resulted in drastically different Tags in the 

document. 
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c  

Figure 28 Table used to design form with entire form in one Table data Cell. 

I then deleted the Tags from the form with the single table and single data cell then tagged 

the document again. 

The results were different again. 

Pieces of the table were tagged as <Figure> and included text while other pieces were 

tagged as <P> or consolidated into a <TD> cell. 

For this one document created to be used as the template for an accessible PDF form, I 

ended up with four different tagging results depending on where I started. 

By the way, in the preceding image, you would have to manually Tag the Table or manually 

separate the individual questions of the form. You cannot leave it lumped together in one 

<TD> cell. This would require a lot of work. 

In each instance of this Word document to PDF example, the resulting PDF would require a 

lot of remediation to ensure that the Tags represent the content in the document. 

This example was sent to Adobe for further analysis to find out what is going horribly 

wrong and hopefully find a way to Tag the content correctly for all scenarios. 
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Fillable Forms from a Scanned Document 
Hopefully, most of the time you will be working with a Word document that you either 

created or provided some help in creating. Even if you didn’t provide insight into creating 

an accessible form, you can still work with the resulting untagged PDF document. 

What happens if you get a scanned image of a form? 

Referring to our hierarchy of tasks, we would need to perform the OCR or text recognition 

first. As we will see in the chapter on scanned PDF documents, the accuracy of OCR or text 

recognition depends on the clarity of the scanned page. 

My recommendation is to take the scanned form and perform the OCR or text recognition 

and test the Tags. The thing you are looking for is accuracy and that after text recognition 

that there are spaces between words. 

 

Figure 29 Paragraph where all the words are together with no spaces between them. 

All of the words are run together with no spaces between them. However, when we look at 

the text on the page, there are spaces between words and everything looks “normal”. 

 

Figure 30 The text for the misrecognized text with no spaces between words.  

If you find that there are significant errors and/or no spaces between words, use a stronger 

OCR tool such as ABBYY Fine Reader1 or ABBYY PDF Transformer,2  

The process would be to use, in my case, ABBYY PDF Transformer to “make the PDF a 

searchable document,” save it and open it in Adobe Acrobat Pro DC. I then use the 

                                                        
1 ABBYY Fine Reader, OCR software: https://www.abbyy.com/finereader/  

2 ABBYY PDF Transformer, OCR software: https://www.abbyy.com/pdf-transformer/  

https://www.abbyy.com/finereader/
https://www.abbyy.com/pdf-transformer/
https://www.abbyy.com/finereader/
https://www.abbyy.com/pdf-transformer/
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Enhanced Scan tools to perform the text recognition and pick the process for a form up 

from that point. 

 

Figure 31 Same text in PDF document after going through ABBYY PDF Transformer and Recognize Text in 
Acrobat. 

…so then adding the form controls and then any links that might appear in the document 

BEFORE tagging the document. 
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Form Tools in Adobe Acrobat 

Always start creating a form with an untagged PDF document! 

 

Figure 32 Prepare Form tools in the Tools Task Pane. 

All form tools are found in the Prepare Form tools in the Tools Task Pane. 

 

Figure 33 Prepare Form tools in Toolbar. 
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Once you activate the Prepare Form tools, you will see both a Toolbar above the document 

and tools in the Tools Task Pane. The Toolbar contains the basic form controls while the 

information in the Tools Task Pane contains any attributes or settings for a form tool. The 

Tools Task Pane also lets you see the form controls added to the document and has menus 

to show the Tab Order of the form controls you add to the form. 

 

Figure 34 Tools specific to a type of form control and list of form controls in document in the Tools Task Pane. 

As soon as you activate the Prepare Form tools, the area of the main document shows two 

options: use the current document as the basis for the form or open another document to 

use as the basis for the form. 

I always open the form template I want to work on before I open the Prepare Form tools 

just as a way of saving time and quickly moving to adding the form controls. 
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Figure 35 Choose the template to use for the form. 

When you choose the template to use for the form, the auto detect form tool begins and will 

give you a message about how many form controls, or things it thinks are form controls, it’s 

found. The template I’m using doesn’t have the lines or symbols to represent form controls 

so no form controls were added to the document using the automated tool. 

This is what I want. I want to add the form controls myself. 

 

Figure 36 Notification of number of auto detected form controls. 
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Note: Remember that if you get the dialog to infer the reading order 

that you need to dismiss it. Allowing the creation of virtual Tags often 

interferes with the ability to Tag the document, and in this case, to 

create an accessible form! 

 

Figure 37 Just say no to inferring the reading order from the document! 

As I’ve mentioned, I don’t usually use the auto-detect tool in Acrobat unless I do have a 

complicated form with tables for layout. I turn off the auto-detect form controls in the 

Preferences dialog (Ctrl + K). After pressing Ctrl + K, go to the Forms category and uncheck 

the Check Box to auto-detect form controls. 
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Figure 38 Preferences dialog in Acrobat showing Form preferences. 

At any time I can go back to the Preferences dialog and turn this feature on again.  

If you have the auto-detect form controls option turned on, it will always try to find form 

controls in your document when you use the Prepare Form tools. You will get a notification 

dialog telling you how many form controls the auto-detect tool found. 

Once the OK button is activated to dismiss the notification of the number of form controls 

added, we need to make some changes to some of the settings. The first is to show the Tab 

Order of the form controls and to show them by structure. 
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Figure 39 Show Tab Numbers setting in the Prepare Form Tools Task Pane. 

I change the setting in this context menu from Order tab Unspecified to Order Tab by 

Structure. 

These settings are found to the right of the “Fields” text in the Tools Task Pane. The settings 

are under the icon that looks like a series of lines in a document. There is no Tooltip for this 

icon. 

 

Figure 40 Notification that you will need to first order the form controls manually. 

The next settings to check are the two under the Tools icon just above the word “Fields” in 

the Tools Task Pane. The two items that should be checked by default are: 

 Show Tab Numbers. 

 Highlight Existing Fields. 
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Figure 41 Tools settings in the Prepare Form Tools Task Pane. 

The last setting to look at is the sort order of the form controls. By default the form controls 

should be sorted by their Tab Order…the order in which a person would Tab through them 

to fill them out. The other option is alphabetical. 

 

Figure 42 Sort order of the form controls setting. 

For the sort setting, we are just verifying that the Tab Order is the default and that we 

know where this setting is if the sort order is somehow not doing what it is supposed to. 

The Importance of ToolTips 
Most of us who use screen readers have a keyboard command that lets us get a list of form 

controls in a PDF document. We can also use this keyboard command on HTML pages. 

Typically we just get the list of form controls and begin filling out the form if it is a simple 

one. For forms that are not well organized or have the Tab Order out of whack, getting the 
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list of form controls often provides insight into what information will be required. It is a 

fast way of getting an overview of the form before going back and reading the instructions. 

If the only thing you could see” on the form were the labels or ToolTips for the form 

controls, would you be able to fill out the form and send it in independently? Would you 

know what form controls were required? Would you know what the Check Box relates to, 

the Radio Button is for? 

Without proper Tooltips we will hear “Check Box not checked” or “Radio Button not 

checked” or “edit.“ 

 

Figure 43 ToolTip area of the Properties dialog. 

If this were all you heard what decisions would you be able to make about the type of 

information you need to provide to fill out the form? 

It is important to provide the context for the form control in the ToolTip. Keep in mind that 

ToolTips provide equal information and not “more” information than anyone not using 

adaptive technology would get when filling out the same form. If you look at a form control 
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and want to make things clearer, this goes back to the design of the form. The intended use 

of ToolTips is NOT to provide more information than is already on the form. 

If we consider a date field where the text on the form says the format is to be “yy-mm-dd” 

but we do not provide that information in the ToolTip, someone who is using the list of 

form controls, is tabbing from form control to form control or who has not read the text-

based instructions will not know that you are specifying a particular date format and will 

get several error messages until they “figure it out.” Any special instructions such as a word 

or character limit, format type or any other unique instructions for a form control must be 

in the ToolTip for that form control. 

Note: As mentioned in a previous chapter in this book, when using 

acronyms in a form control, don’t write lowercase letters with no 

spaces. An example would be the American Housing Association 

which, when written as “aha” is pronounced “aha! Telling someone to 

contact their local aha office doesn’t make sense. Even if you type AHA 

but omit the spaces it will be pronounced as a surprised utterance. 

The correct way to add acronyms to ToolTips would be A H A. Of 

course you can always write out the organization in long hand. 

Required Field Notification 
There is some discussion about the proper way to indicate that a form control is required. 

Some say that the proper format is to add the word “required” to the ToolTip. Others say 

that just adding an asterisk is fine as long as it is indicated somewhere on the form that an 

asterisk means a required field. 

Remember that although we can’t provide different information in the ToolTip, the purpose 

of the ToolTip is to help people fill in this form who not only may not be able to see it, but 

may have learning or cognitive disabilities as well. From my perspective, adding the word 

“required” is less confusing and clearly identifies the form control as being required 

whereas an asterisk is easy to miss visually or if you are having form control ToolTips read 

out to you. I tend to err on the part of clarity of purpose when working with form controls. 

The first opportunity you have to check the Required Check Box is when you first create the 

form control. In this example, I’ve created a text form control. When I release the mouse 

button, the Required Check Box is in the resulting pop-up dialog. 
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Figure 44 Required field Check Box when you first create a form control. 

The next opportunity you have to make a form control Required is when you open the 

Form Control Properties. You can do this by choosing All Properties from the initial form 

control dialog or by selecting the form control and right clicking on it to show the context 

menu. Properties is the first item in the context menu. 

 

Figure 45 Required Check Box in the form control Properties dialog. 
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To check the required Check Box for a new or  existing  form control: 

1. Select the form control in the document. It will change colour. 

2. Right click on it and choose Properties from the context menu. 

3. In the Field Properties dialog, check the “Required” Check Box on the General tab. 

a. You can do this while you are creating the form control and working in the 
Properties dialog. 

4. Add the “- required” without the quotes to the ToolTip for the form control at the 
end of the ToolTip. For example: First name, required. 

5. Press Alt + C to Close the Properties dialog when you are finished. 
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Text Form Controls 

I’ve created a sample form that is simple and contains the form controls we’ll work through 

in this chapter. The sample has text form controls, checkboxes, Radio Buttons, a list of 

options and a multiline text form control.  

Go to the Tools Task Pane and activate the Prepare Form tools. Creating a form is a mouse 

dependent activity so this chapter will not include a lot of keyboard commands. 

Activate the Text form control button in the Prepare Form Toolbar. Immediately the mouse 

pointer changes to cross hairs with a blue rectangle representing the form control. Place 

the upper left corner of the cross hairs/blue rectangle where you want the form control to 

be placed. Click the mouse button to anchor the form control. 

 

Figure 46 Adding a text Form Control. 
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Once you release the mouse button, a pop-up dialog appears. The dialog is bright yellow so 

it is easy to see. 

I always give the form control a meaningful name. This lets me find it easier in the list of 

form controls in the Tools Task Pane. 

 

Figure 47 Form control with initial Properties dialog. 

Remember to check the checkbox for Required if this is a required field. 

The next important thing to do is to provide a ToolTip for those who use screen readers or 

TTS tools. 
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Figure 48 Field Properties dialog with ToolTip edit area highlighted. 

The ToolTip should give the person accessing the form control the same information that 

someone has visually. ToolTips are not meant to provide extra information, just the same 

information. Keep in mind that anything you type into the Tooltip must be read in its 

entirety and is not part of the text layer of the document. 

 

Figure 49 List of form controls on a page/in a document in the order they are to be filled in. 

When you add any form control, it will appear in the Tools Task Pane with the name you 

give it. For example, instead of being named “Text1” in the list, the sample text form control 
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I created will be identified as “Name.” I can easily find it in the list of form controls on the 

page.  

Also notice that in the Tools Task pane the form is divided into pages. This also helps you 

identify where a form controls is to ensure it is on the right page. 

 

Figure 50 Finished text form control. 

When you are working with a form control it is outlined in blue. Once you remove focus 

from it, it is outlined in red if it is a required field. If it is not a required field, it is outlined in 

black.. 

 

Figure 51 Required Text form control with focus removed. 

The way to size a text form control is to use the handles to make it wider or the handle in 

the lower right corner to make it large enough for multiple lines of text. 

Note: At this point in creating a form we can use adaptive technology 

such as a screen reader to test the ToolTips and the Tab Order of the 

form controls, but not any of the informational or instructional text 

because we haven’t tagged it yet. Using a screen reader in Preview 

mode will also tell you if there are any typos in your ToolTips! 

Previewing a Form 
At any time during the form development process you can preview the form by activating 

the Preview button located just above the Tools Task Pane. Once activated, the Preview 

button becomes and Edit button. Activate the Edit button when you want to return to the 

form to continue adding and editing the form controls. 
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Figure 52 Buttons to switch between Preview and Edit mode while creating a form. 

While in Preview mode, the Tools Task Pane disappears. 

Remember to clear any answers out of a form control before you move back to Edit mode. 

Clearing a Form After Preview 
Once you’ve tested the form using a screen reader in Preview mode while in the Prepare 

Form tools, you can clear the form data so that none of it remains when it is published or 

when you retest the form. 

To clear the form or reset I after testing, go to the Prepare Form tools in the Tools Task 

Pane and activate the More (tools) icon. It is located either the text says “More.” 

From the More tools context menu, choose Clear form. 

You are good to go and can now either continue building your form or Tag it. 
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Figure 53 More Tools, Clear Form option. 

Limiting the Number of Characters in a Text Form 

Control 
You can limit the number of characters in a text form control. This is helpful when the 

information you want is a postal or zip code or a phone number. For zip or postal codes, 

keep in mind that in Canada there is a space between the two groups of three characters 

and for some areas in the US, there is a hyphenated zip code with more than five 

characters. 

To adjust the number of characters for a text form control, click on the Options tab in the 

Properties dialog. 
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Figure 54 Options tab in text form control Properties dialog. 

By default, the Check Spelling Check Box is checked for text based form controls. This 

should be left checked. 

If you want to limit the number of characters, the Check Box for “Limit of” must be checked 

and then a number of characters…not words…must be entered. When choosing to limit 

characters, keep in mind the possible length of names and in the case of a multiline text 

form control, the relationship between the number of characters and the number of words. 

To determine a number of characters versus words I use the ability in Microsoft Word to 

generate sample text in a document. 

By typing =rand(5) then pressing Enter, you create random sample text from the Microsoft 

Help documentation. In this example the number five represents five paragraphs each with 

a default number of three sentences. If you want to change the number of sentences, then 

type (5, 8)  which will give you five paragraphs each containing eight sentences. 
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You can then press Alt + R, W for the Review Ribbon, Word Count and take a look at the 

number of words and characters to determine an appropriate number of characters for 

your text form control. 

 

Figure 55 Word Count dialog in Microsoft Word. 

The other thing to remember when limiting characters in a text form control is that a space 

between words counts as a character. This information is provided in the Word Count 

dialog in Microsoft Word.  

There is also a Check Box to allow rich text editing.  I don’t see this used much in PDF forms 

but thought I’d mention it. 

Form Control Appearance 
As well as setting Options for a form control, you can choose how the form control is 

visually presented to the end-user. 

Note: By changing the appearance of a form control you may 

override any accessibility features and/or settings that the person has 

in place to make forms easier to access and fill out. I highly 

recommend that you do not make any changes to the appearance of a 

form control. 

The Appearance tab in the text form control Properties dialog lets you set a default font an 

font size as well as choosing a fill and border colour. 
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Being able to change the font and font size comes in handy when your form control is too 

small to allow the text to be completely visible.  

Adobe acrobat and reader have user Preferences for forms. I present this topic to show 

what can be done to the visual appearance and that it shouldn’t necessarily be done.  

 

Figure 56 Appearance tab in the text form control Properties dialog. 

Note: If you are going to change the font and/or font size make sure 

you change it for every form control you use in the form/current 

document that requires text entry! 

When you are changing the font size and style keep in mind the size of the text form 

control. For example, if you have a limited amount of space to put the form control, you 

don’t want to change the font size to something that is not going to fit into the form control 

area. Likewise remember that not everyone with a visual disability uses larger print. For 

those who have tunnel vision or peripheral vision, a larger font size is not necessarily 

easier to read. 
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The other aspect of the appearance of a form control is the fill colour and border. Within 

the Preferences of both Acrobat and Reader, there is a default of a red border for required 

fields and a default of blue shading to show where form controls are in the document. If you 

choose to change the fill and border you may inadvertently create an accessibility barrier. 

 

Figure 57 Example of a text form control that creates barrier to accessibility. 

The preceding image shows a text form control with bright yellow fill and a purple dashed 

thick border around it. 

 

Figure 58 Form Preferences in Adobe Acrobat or Reader. 

In reality, the only time you may need to go into the Appearance tab is when you have a 

form control with print larger than the form control and you need to resize it. 

For example, later in this chapter we are going to walk through the steps to make a List 

form control which takes up a lot of room on a form. 

The following tow images show the original size of the text in the List form control and the 

size of the text once it was resized to fit all of the possible answers. Notice that when this 

was done, the form looked a bit off in terms of design. This is another reason you need to 

think of which form controls you want to use for the form when you create the template. 

Ideally, you want to make sure that there is enough space to add this List form control AND 

all of the possible answers. 
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Figure 59 List form control with regular size text (Top) and resized text (Bottom). 

If you are going to experiment with the appearance of a text form control, there is no reset 

button or default button so that you can return to the default settings for this and other 

form controls. I ended up having to revert to a version of the form before I started adding 

the form controls or before I changed the appearance of the form control in order to return 

to the default settings of the black outline and blue fill colour. I tried changing this manually 

in the Appearance tab but nothing would get me to the point where the form controls were 

at the default settings except going back to a version of the before I changed the 

appearance of the form control. Another good reason to have a versioning process! 

Multi-Line Text  Form Controls 
I’ve previously stated that in creating a form template that includes a multiline text form 

control the use of writing guide lines should be avoided. The reason is that this creates 

accessibility barriers for those filling in the form digitally. In 2016 most forms are going to 

be filled in online, not printed out and hand written. Typically the only hand writing is a 

signature if there is no access to a certified digital signature. 

In the following sample, there is an area for a street address that has been identified in the 

form by using the underline. 
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Figure 60 Address "form field" created using the underline in Word. 

Sometimes the automatic form detection tool gets confused about what to do. This is 

especially true when the underline or a table has been used to provide handwriting guides 

for forms to be printed and filled out. This needs to be repaired. 

 

Figure 61 Multiple "lines" detected using automatic field detection in Acrobat. 

This is not the correct recognition of the form control. Remember that the form detection 

tools are mechanical and cannot interpret intent.  This has also made more work for you! 

Logically speaking, if someone were entering their address digitally they would not type in 

the street number, look for the next form control to enter the city or province and then look 

for the next form control to enter their postal code and country. Visually this set of 

information is tied together by the underline. Digitally it needs to be tied together using 

one text field/control not four. However if your form does require separate entry fields for 

each piece of an address, each form control would have its own label such as Street 

Address, Apartment or Unit Number, City, Province/State, Country and Postal Code/Zip 

Code. In our form, all of this information is consolidated in one form. 
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Figure 62 Properly identified multi-line text field. 

To create a multiline text form control: 

1. Click on the Text icon in the Prepare Form Toolbar at the top of the document. 

2. Position the text form control where you want it in the document and click to anchor 
it. 

3. Give the text form control a meaningful name, something like Address, Comment, 
Abstract or Experience. 

4. Click on the link to show All Properties. 

5. Add the Tooltip for the text form control. 

6. Move to the Options tab and check the Check Box for Multiline. 

7. Click the Close button to return to the form. 

There is also a Check Box to show the scrollbars which you will want to make sure is 

checked. It is checked by default. 

Using this type of text control a person can continually enter the necessary text without 

having to suspend their thoughts, move to the next part of the form control and pick their 

thoughts up again to continue.. 
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Figure 63 Tag Properties dialog showing Options tab with Multiline checked. 

The key to creating accessible forms is to look at the purpose of the form control and how 

best to facilitate digital or online filling in of information. Even for those of us without 

disabilities it is counter intuitive to have a single concept or train of thought scattered 

throughout several text controls/fields. 

The failure to create one multi-line text control for more than one line of information is a 

common mistake made when creating fillable PDF forms but represents a significant 

barrier to filling out the form. 

Formatting a Form Control 
While we are talking about Text form controls, it is worth talking about the ability to 

“format” the form control. This is not the same as the things you can do on the Appearance 

tab. 

By “formatting” a form control, I mean something like a date field where you want the 

person to enter the date in a specific way. For example, you want them to type the date 

yy-mm-dd instead of mm-dd-yy. 
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To begin, create the Text form control for the date. 

 

Figure 64 Text form control used for date. 

Make sure that in the Properties dialog that the format you want is in the ToolTip. This lets 

those filling in the form know what they need to type. 

 

Figure 65 ToolTip for date form control with the required date format. 

The next step is to go to the Format tab in the Properties dialog and choose Date as the 

format for the form control from the Dropdown list. Once you do, the various date formats 

will be visible. Make sure you choose the format you have indicated in the form itself!. 
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Figure 66 Format tab showing Date chosen and correct date format as indicated in the form instructions. 

You can switch to Preview to test the format of the Date form control. 

If I type “2016-06-21” the text gets converted to “16-06-21.” 

 

Figure 67 Preview of the Date form control with the applied date formatting. 
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If I type the full date, June 21, 2016 I get an error message. 

 

Figure 68 Incorrect date entry warning message. 

However, If I type “19-06-21” it is accepted as a valid date. 

I have had to use the Custom date from the list of possible dates in the Format tab. This is 

easy to do and I’ve had no problem customizing a date on several forms. 

You choose custom and then enter the format you want the date to be entered in into the 

form control that appears just under the list of possible date formatting options. You can’t 

however, add a Custom date as one of the options that will appear in the list by default. The 

date format must be customized for each form where a Custom date format is needed. 

The other options in the Format tab are: 

 None. 

 Number. 

 Percentage. 

 Date. 

 Time. 

 Special. 

 Custom. 



Draft Copy 

 

 

Figure 69 List of possible formats for a form control. 

The Format tab is only available in the Properties dialog for the Text form control. It is not 

present in other form controls. 
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Check Boxes in a PDF Form 

I will admit that I sometimes get confused as to when to use Check Boxes and when to use 

Radio Buttons. I tend to get distracted by the visual form and don’t see that Radio Buttons 

would be the better choice. It’s always good to read the question carefully before adding 

the form control to avoid removing it and starting again!. 

Check Boxes are used when you want someone to provide more than one answer to a 

question. Radio Buttons are used when you want someone to only choose one answer. 

Seems simple enough, but I still can get distracted by the visual aspects of the form! 

Sometimes the confusion as to which form control to use is a result of the form designer 

using symbols for the action in the form. For example, if someone has used circles when 

they should have used squares, indicating Radio Buttons instead of Check Boxes, we tend to 

add the corresponding form control without examining the question or questioning the 

intent of the form designer. 

The following image shows a question with more than one possible answer. The 

respondent is asked to choose as many answers as apply. 
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Figure 70 Question requiring more than one possible answer. 

The first step is to make sure the Prepare Form Tools are available and to activate the 

Check Box tool in the Prepare Form Toolbar. 

 

Figure 71 Check Box tool shown in the Prepare Form Toolbar. 

Once you activate the Check Box tool, your cursor becomes a Check Box and you see the 

guides for lining up the Check Box. Place the Check Box where you want it in the form and 

click the mouse button to anchor it there. 

The Properties pop-up dialog appears and focus is in the edit area where you can rename 

the form control. I always choose a name that is meaningful to the content of the form 

control so that when I look in the list of form controls in the Tools Task Pane I can easily 

find which one I’m looking for. Of course, you can just accept the default name. 

 

Figure 72 First Check Box placed in form with initial dialog. 
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Give the form control a meaningful name. 

Activate the All Properties link which will open the Properties dialog. 

When the Properties dialog opens, give the form control a ToolTip. In this example, I would 

add the ToolTip “I access PDF documents at work”  without the quote marks. 

Move to the Options tab in the Properties dialog. 

We are going to check and make sure that the value of this Check Box, when checked, is Yes. 

In the Options tab, this is the edit area called “Export Value.” Export values let you send the 

data from a form by e-mail to an Excel spreadsheet. This saves time collating the data from 

a form. 

 

Figure 73 Check Box Options showing "Yes" as the export value. 

When you have checked the value, Close the Properties dialog and repeat the process 

making sure that each of the Check Boxes have a ToolTip and an export value of “Yes.” 
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Figure 74 Adding a second Check Box showing the guide lines for placement. 

As you place the cursor where you want subsequent Check Boxes, you’ll see the guiding 

lines to help you place the Check Box in line with other Check Boxes. These guiding lines 

appear whether your Check Boxes are horizontal or vertical. 

 

Figure 75 Complete set of Check Boxes. 

As the Check Boxes are added, you’ll be able to see them in their logical order in the Tools 

Task pane for this page of the form. 

In looking at the Tools Task Pane, we can see why it is a good idea to provide form controls 

with meaningful names. I can quickly look at the list of form controls and figure out which 

ones are Check Boxes. I could have included the form control identity for Name by calling it 

“Name Text Field.” 
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Figure 76 List of form controls on page 1 of the form in their logical Tab Order. 

At this point, don’t worry about the size of the Check Boxes. There is a topic in this chapter 

on resizing form controls. 

Note: At this point in creating a form we can use adaptive technology 

such as a screen reader to test the ToolTips and the Tab Order of the 

form controls, but not any of the informational or instructional text 

because we haven’t tagged it yet. Using a screen reader in Preview 

mode will also tell you if there are any typos in your ToolTips! 

Duplicating Check Boxes in a PDF form 
If you have a few Check Boxes for a question in a form, you can add them using the ability 

to duplicate Check Boxes (or other form controls). 

The first step is to right-click on the existing Check Box and choose “Create multiple 

copies.” 
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Figure 77 Context menu showing "create multiple copies" option. 

When you choose to create multiple copies, a dialog opens letting you choose the direction 

and other settings for the form control. 

If your Check Boxes or other form controls are placed vertically, the first Check Box lets you 

choose how many Check Boxes you want vertically (down) while the second Check Box lets 

you choose how many Check Boxes you want horizontally (across). The example I’m using 

is for Check Boxes but you can explore this capability to see if it is useful for other form 

controls. 
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Figure 78 Creating multiple form controls dialog with sample settings. 

As we can see in the preceding image, the number of additional Check Boxes is displayed in 

a series of 2 columns each with 4 Check Boxes. We only need a total of 4 Check Boxes so the 

second setting, “Copy selected fields across” should be 1. We set the “Create selected fields 

down” to 4. 

The settings are as follows for the vertical example: 

Copy selected field down = 4. 

Copy selected field across = 1. 
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Figure 79 Create multiple fields showing the correct number of Check Boxes in the settings dialog. 

If we were working with horizontally placed Check Boxes, the numbers would be: 

 Copy selected fields down = 1. 

 Copy selected fields across = 4. 
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Figure 80 Create multiple form controls horizontally settings. 

Once you’ve created multiple instances of a Check Box, you need to go into the Properties 

dialog and make the necessary changes. 

In the example for this book, when I created multiple copies of the Check Box for “I access 

PDF documents at work” I then need to go into the Properties for the other Check Boxes for 

this question and change the text to: 

 I access PDF documents at home. 

 I access PDF documents for education. 

 I access PDF documents for leisure. 

I only have to change a word or two in the Tooltip which again saves time. The question 

part is the same for all of these Check Boxes. The only difference is the answer that will be 

chosen. 
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Figure 81 Check Box Properties dialog. 

The “hard part” of using this tool may be remembering to change the text in the ToolTip! 

Pinning Form Control Tools 
On the Prepare Form Toolbar is a push-pin that lets you keep using one form control tool. 

For example, if you have a lot of Check Boxes to create, you can pin the Check Box tool and 

whenever you move the mouse pointer over the form, you’ll be able to add a Check Box. 

 

Figure 82 Pin button on the Prepare Form Toolbar. 

It doesn’t matter whether you activate the Pin button or the form control first. One thing to 

note about using the Pin tool at this point in time is that you will NOT get the pop-up dialog 

for initial Properties You will have to right click on each new form control and add the 

appropriate properties. 

Once you finish adding the Check Boxes, activate the Pin button again to turn it off. You can 

then activate other form tools. You might be able to simply keep checking different form 
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control tools but I choose to pin and unpin form control tools so that I keep things straight 

in my own mind. You may have a different workflow. 

 

Figure 83 Prepare Form Toolbar with the Pin button activated. 

The following image shows the mouse pointer for “pinning” the ability to add several Check 

Boxes at the same time without having to go back to the Prepare Form Toolbar and 

activating the Check Box tool repeatedly. 

 

Figure 84 Check Box tool pinned in Form tools. 

In the preceding example, I combined the use of the ability to create multiple Check Boxes 

with the ability to Pin the Check Box tool so that I saved time creating a large number of 

Check Boxes. 

Distributing Form Controls Evenly 
Now that we have a series of Check Boxes, we need to make sure that they are visually 

aligned to their corresponding answer. If you didn’t use the ability to create multiple 

instances of a Check Box, your Check Boxes may line up.  

 

Figure 85 Check Boxes placed horizontally in a PDF form. 
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In this example, they don’t because I used the ability to create multiple instances of the 

same Check Box. I need to manually move them to roughly the same position in the grid of 

answers. 

 

Figure 86 Repositioning the Check Boxes in the PDF form. 

Why did I include this as a topic? 

In order to move the form control, I had to make sure that the mouse pointer was on the 

band in the Check Box where the name of the Check Box was. 

To do this, I zoomed in so that the band where the name (Work1, Home1 and so forth) 

were clearly visible. I was then able to drag the Check Boxes to where I want them in the 

form. 

In the topic on Radio Buttons, we’ll go through the process of resizing and aligning form 

controls vertically and horizontally. After being frustrated at not being able to target the 

name of the Check Box/form control to move it…and making them all sorts of sizes as a 

result…I thought that this was worth a separate topic in this chapter! 
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Radio Buttons in a PDF Form 

Some people find creating Radio Buttons confusing. Part of the confusion is in ensuring that 

they are all grouped together and not created separately like Check Boxes. The key to 

having them all work as a set or series of options is to make sure they all have the same 

“name.”  This is a lot easier in Acrobat Pro DC. 

There is a rumour that Radio Buttons in PDF documents are not accessible. I have not come 

across a correctly created set of Radio Buttons that is not accessible. I go back to the 

statement I made in the topic on Check Boxes, sometimes we are distracted by the visual 

place markers that the form designer has added to the document. For forms, we really need 

to read the question and determine which form control is best for the question and its 

answers. We can’t always trust the use of symbols or markers for form controls added to 

the form template by a document author. 

The following image shows a sample question where Radio Buttons would be appropriate. 

It is a Yes/No question. Radio Buttons are also used when you have a multiple choice 

question but you want someone to choose only one answer. For example, if we look at the 

question we used for Check Boxes, if the question was “which one area of your life do you 

access PDF most, then the appropriate form control would be Radio Buttons. Radio Buttons 

allow for only one choice. 
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Figure 87 Sample question where Radio Buttons would be used. 

The first step is to activate the Radio Button tool in the Prepare Form Toolbar. 

 

Figure 88 Radio Button tool on the Prepare Form Toolbar. 

The mouse pointer becomes a square with the same guiding lines as we saw with a Check 

Box. You can line up the Radio Button with the existing form controls in the form. Once 

you’ve placed the Radio Button where you want it, click the mouse to anchor it. The 

Properties pop-up opens. 

 

Figure 89 Radio Button being added to a form. 
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There is a difference in the Radio Button pop-up dialog. The first edit area is for the choice 

or answer that this Radio Button represents. The second edit area is for the name of the 

group. In this example, the question asks whether you live in the province of Ontario. 

 

Figure 90 Radio Button pop-up dialog. 

This pop-up dialog makes it easy to create the set of Radio Buttons. This process is a lot 

easier than in previous versions of Acrobat. 

First we want to give the group of Radio Buttons a meaningful name. Since the question is 

asking about whether you live in the province of Ontario or not, I’m going to call the group 

of Radio Buttons “province.” 

 

Figure 91 Radio Button pop-up dialog with information filled in. 
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The current choice, or Choice1 is Yes. Replace the Choice1 text with the word Yes. Although 

the space that the Radio Button takes up is square, notice that within that square is the 

circle which is your Radio Button. 

At this point, I usually create any other Radio Buttons so that I don’t forget…and it is easy to 

do from this point rather than creating another Radio Button and remembering to put the 

same group name in the Group Name edit area. 

 

Figure 92 Second Radio Button added to the group. 

Once I release the mouse button after positioning the Radio Button, I can see that the Group 

Name is Province and the option is Choice1. I change Choice1 to No.  

 

Figure 93 Second Radio Button added to the Province group. 

Since this is the last Radio Button of this group that I need, I can then choose to open the All 

Properties dialog and add the Tooltip for the group of Radio Buttons. 
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Figure 94 Radio Button Properties dialog showing ToolTip. 

The ToolTip you enter will be used as the ToolTip for every Radio Button in the group. 

Don’t include any of the answer information! 

If the question or statement the response is for is long, summarize it here. Remember that 

someone using TTS or Text-to-Speech or a screen reader is going to have to listen to the 

entire ToolTip. On the other hand we need the ToolTips to provide enough information 

about the question or statement we are responding to so that if we get a list of form 

controls we can fill in the information independent of surrounding text on the form. 

When I opened the Radio Button Properties dialog I had just finished creating the No Radio 

Button. If we look at the Options tab, we can see that No is the Export Value for this Radio 

Button. 
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Figure 95 Second Radio Button showing the Export Value of No. 

If the Radio Buttons are grouped or added as a set with the same name, built on the same 

initial Radio Button, they will behave as Radio Buttons in the PDF form. This means that 

you can Tab to the first button and then use the Left, Right, Up or Down  Arrow keys to 

move to the previous or next button.  Of course if you are using a screen reader you would 

be able to get a list of the form controls and move to and select the Radio Button you want. 

Some screen readers and TTS tools now have you press the Spacebar to actually make a 

choice rather than having the choice made automatically. This avoids confusion on the part 

of the person filling out the form as to whether they have actually selected the option or 

not. 

If we look in the Tools Task Pane, we can see the group of Radio Buttons. 
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Figure 96 Group of Radio Buttons in a form. 

Now let’s look at how to resize and align the Check Boxes and Radio Buttons we’ve added 

to our form. 

If we exit Prepare Form and view the document, we see the circles representing the Radio 

Buttons. 

 

Figure 97 Radio Buttons as they appear in the form. 
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Note: At this point in creating a form we can use adaptive technology 

such as a screen reader to test the ToolTips and the Tab Order of the 

form controls, but not any of the informational or instructional text 

because we haven’t tagged it yet. Using a screen reader in Preview 

mode will also tell you if there are any typos in your ToolTips! 

I’ve also created a sample form where the Radio Buttons are in a table and are placed 

horizontally.  

 

Figure 98 Radio Buttons in a table. 

One of the advantages of the cross hairs associated with form controls is that it is easier to 

line them up if you have a series of them. 

 

Figure 99 Benefits of guiding lines associated with form control creation. 
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We’ll go through the tagging of this type of form (with a table for design layout) in the 

section of this chapter on tagging the form. 

Aligning Form Controls Horizontally and Vertically 
For Radio Buttons or Check Boxes across a row, you want to align them horizontally. 

Aligning them vertically will put them all on top of each other.  

I know this because I’ve done it! I forgot my horizontal from vertical orientation! 

If you weren’t able to do this when adding the Check Boxes or Radio Buttons, align Radio 

Buttons or Check Boxes in a column vertically so that they are more uniform and 

consistent. 

In previous versions of Acrobat when it wasn’t as easy to add consistently sized Radio 

Buttons and Check Boxes, we had a wide variation of sizes that caused a lot of laughter 

when we finally got around to aligning and sizing them. Now, each Radio Button and Check 

Box is created “equally” which means that we don’t have to resize them unless the space for 

them is smaller.  

We only need to align Check Boxes or Radio Buttons if we didn’t do this when creating 

them. 

 

Figure 100 Series of Check Boxes selected with alignment options context and sub-menu open. 

To begin the process, make sure you are in the Prepare Form tools. 
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To align Check Boxes or Radio Buttons, select all of the Radio Buttons or Check Boxes in a 

row by holding down the Ctrl key and then right-clicking on them with the mouse. All of 

them will be blue in colour as shown in the preceding image. 

Choose “Align, Distribute or Center” from the context menu. This will open a sub-menu and 

you can either press the letter H or click on the “Align Horizontally” or V for “Align 

Vertically.” There are other alignment options that you can explore on your own. 

Note: I recommend working on a sample form or a version of your 

form before you work on one with a deadline. In versions of Adobe 

Acrobat prior to Adobe Acrobat DC there was no “undo” functionality 

but there is now! Adobe acrobat Pro DC lets you press Ctrl +Z to Undo 

something. I still recommend creating versions of your document in 

case you can’t Undo as far back as you need or for some reason the 

action you did can’t be undone. The ability to Undo an action will be 

an ongoing product improvement with Adobe Acrobat DC and 

subsequent versions. 

Resize Radio Buttons 
You can resize Radio Buttons or Check Boxes so that they are all the same size which looks 

better on a form.  Once you select all of the form controls, including the one you manually 

resized, right click on the one you resized in order to make that one the template for the 

others. This is important! 

This is another activity you might want to use the Zoom and the ruler at the top and left of 

the document for. Size the first Radio Button or Check Box to the size you want using the 

handles and dragging the Check Box or Radio Button to the size you want. Then select the 

rest. 

To select the Radio Buttons or Check Boxes you want to be the size of the one you resized, 

hold down the Ctrl key and then use the mouse to select all of the Check Boxes or Radio 

Buttons you want to be the new size, including the form control you resized. 

Put the mouse over the form control you resized and use the right mouse button to open 

the context menu. 

Once you have the Radio Buttons or Check Boxes selected, position the mouse over the 

form control that is the size you want the others to be then use the right mouse button to 

open the context menu and choose “Set Fields to Same Size” or press the letter S. This 



 

Page 81 of 112 

 

opens a sub-menu where you can set the Radio Buttons or Check Boxes to the same height, 

width, or both height and width. 

 

Figure 101 Resize Both from the context menu. 

Note: If we had used symbols to represent the Check Boxes or Radio 

Buttons, it would be very difficult to line them up so that you didn’t 

see part of the symbol through the Check Box or Radio Button. This 

can create visual confusion and a barrier to accessibility. 
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Figure 102 First Radio Button sized smaller as template for size of others in the series. 

It is important to make sure that the mouse is over the Check Box or Radio Button that is 

the size you want and then use the right mouse button to open the context menu because 

this is the Check Box or Radio Button that will be used as the size template for the others in 

the series.  

 

Figure 103 Series of Check Boxes with first one resized. 

You may have to realign the form controls once they are resized. You can do this manually 

by deselecting all of them and then using the Left, Right, Up and Down Arrows to position 

them. This is a useful technique when there is only a little bit of space in which to position 

the form controls. 

Another option, when you do have space is to keep all of the form controls you resized 

selected and use the context menu. 

Select all the Check Boxes or Radio Buttons you want to align and use the right mouse 

button to open the context menu. Choose Align, distribute or Centre and then either 

Vertically or Horizontally. 
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Figure 104 Resized Check Boxes in the PDF form. 

One caution is that you may inadvertently choose one of these options that will stack the 

form controls on top of each other. I do this frequently when I get the vertical and 

horizontal positioning mixed up. 

If the form controls ae in a table, you can align them both vertically down a “row” and 

horizontally “across” the page. 

You can also select non-contiguous form controls and resize them so that all of the Radio 

Buttons and/or Check Boxes are the same size on a page.  
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Dropdown Lists 

You can add a Dropdown list to a PDF form and have it accessible. Once again we look at 

the ToolTip and value for the selection. Creating Dropdown lists is a bit different in that all 

of the options are in one property dialog instead of being assigned for each component or 

choice as you have with Radio Buttons. 

 

Figure 105 Sample question for a list form control. 

The sample question we are working with asks students to identify their status. Eventually 

this will be a status of either full time, part time or continuing education students. 

The first step in creating a List form control is to click on the Dropdown List Form Control 

button in the Prepare Form Toolbar. 

 

Figure 106 Dropdown List button in the Prepare Form Toolbar. 

The mouse pointer or cursor will be displayed as a rectangle with guiding lines when you 

move it over the document. 

This is not generally the size of a Dropdown list box and we need to ignore its size for the 

moment and place it in the right area of the document. 

When we click on the document to place the list box, the familiar yellow pop-up dialog 

opens with some options. 
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Figure 107 Dropdown List with initial pop-up Properties dialog. 

We need to choose the “All Properties” link once we give the form control a meaningful 

name.. 

 

Figure 108 Dropdown List Properties dialog. 

When the Dropdown List Properties dialog opens we need to add a ToolTip for the form 

control. For this Dropdown List it will be “What is your student status?” 

As I stated earlier in this section, the options are going to be full time student part time 

student and or continuing education . 
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Go to the Options tab to move to the options for this form control. Focus will be in the edit 

box where you can type the first option which will be Full Time Student. 

 

Figure 109 Dropdown List Options in the Properties dialog. 

Once you type Full time, Tab to the Value edit box and enter a value of 1. This means that if 

you decide to send the data from the form to Excel the item of full time student will have a 

value of 1. 

Press Alt + A to Add Full Time Student to the list. Focus will stay in the edit box with the 

text Full Time Student but you will see that the text has been added to the list in the lower 

part of the dialog. 

Type over the text Full time Student with the text Part Time Student and give this option a 

value of 2. Press Alt +A to Add the item to the Dropdown List. 

The last option we’ll add is Continuing Education Student and it will have a value of 3. 
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Make sure you click on the first item in any list once you are finished adding items to the 

list. This signals Adobe Acrobat Pro to make this option the first one displayed in the 

Dropdown List. 

You can move the items up or down in the list using the Up or Down button depending on 

what the most frequent responses are.  You can allow multiple selections however; keeping 

in mind accessibility and people with learning or cognitive disabilities I would most likely 

use Check Boxes for multiple selections. 

To move items, select an item in the list and then activate the Up or Down button by 

pressing either Alt + U or Alt + letter O. 

 

Figure 110 Dropdown List option selected showing Up and Down buttons. 

If you’ve made a spelling mistake or added a choice inadvertently, there is also a Delete 

button. To delete an item, select it in the list and activate the Delete button by pressing Alt 

+ D. 
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Figure 111 Dropdown List option selected showing Delete button. 

Press Alt + C to Close the Dropdown List Box Properties dialog once you are finished. 

Use the Zoom and the rulers at the top and left of the document to adjust the size of the list 

box. As with images and the other form controls, there are handles that you can locate and 

move. You can also then move the list box itself to a more usable location in relationship to 

the label or question “Location.” 

 

Figure 112 Completed and resized Dropdown List form control in document. 

The following image shows the expanded Dropdown List in the document. Dropdown Lists, 

Combo Lists or Lists in form controls can be expanded using the keyboard by pressing Alt + 

Down Arrow. These List form controls are accessible using adaptive technology. 
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Figure 113 Dropdown List expanded in form. 

If you look at the Tools Task Pane, you can see all of the form controls added to the 

document appearing in the order they will be accessed by someone using the keyboard 

with or without adaptive technology. 

 

Figure 114 List of form controls on page 1. 

Note: At this point in creating a form we can use adaptive technology 

such as a screen reader to test the ToolTips and the Tab Order of the 

form controls, but not any of the informational or instructional text 

because we haven’t tagged it yet. Using a screen reader in Preview 

mode will also tell you if there are any typos in your ToolTips! 

List versus Dropdown Lists 
When we added the Dropdown List, there was another List form control in the Prepare 

Form Toolbar. This tool lets you create a List. 

What is the difference? 
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The Dropdown List takes up little space and is expanded by using the keyboard command 

Alt + Down Arrow or by clicking on it using the mouse. Choices can then be made and the 

Dropdown List form controls collapses so it isn’t taking up a lot of room in the form. 

A List takes up as much space as the list of options or choices do in the form. For this 

reason it isn’t often used because the form template has already been created and there is 

simply no room for this type of form control in the document. If you want to use this type of 

form control, the best solution is to create the form from scratch in Form Designer 

(LiveCycle Designer). 

To illustrate the difference in a form, I’ve included the instructions on how to create a List 

form control. 

 

Figure 115 List form control on the Prepare Form Toolbar. 

The first step is to activate the List button in the Prepare Form Toolbar and place the List 

form control in the document. Here we see the difference. Instead of seeing a rectangle, we 

see a square as we place the List form control in the document. 

 

Figure 116 List form control used instead of a Dropdown List. 
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To place the List form control in the document move the mouse pointer, which is now a 

cross hair with a square, to the location in the form where you want the List form control 

and click with the mouse to position it. 

Once you place the List form control in the document you will see the yellow pop-up 

Properties dialog. 

From this point on, the process is the same as for creating a Dropdown List form control. 

Give the List form control a meaningful name and click on the All Properties link which will 

open the List form control Properties dialog. 

 

Figure 117 List Options tab showing list of options that can be chosen. 

In the Options tab of the Properties dialog, add the items. In keeping with our example of a 

Dropdown List, the options would be for full time student, part time student and continuing 

education student. 
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When you have entered the choices and activated the Close button for the List form control 

Properties, you can use the mouse to resize the area taken up by the List form control. 

 

Figure 118 What a List form control looks like completed. 

When someone encounters this type of form control, they review the list and select the 

choice they want as shown in the following image. 

 

Figure 119 The List form control in the form to be filled out. 

The disadvantage to using a List form control is that when someone is reviewing their form 

using adaptive technology or the keyboard, they may not know which choice they made 

because the first choice will be read instead of the selected choice. There also may not be 

enough contrast between the selected choice and the other choices for someone using 

screen magnification or for someone with a learning or cognitive disability to reliably see 

their choice. 

The best form control to use if you are going to create a List form control is the Dropdown 

List form . 

With a Dropdown List form control, as soon as someone reviewing their form enters the 

Dropdown List form control, they see/read their choice, not all items in the list. 
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Combo List Form Controls 
We can create what is called a Combo List form control which lets someone enter their own 

value if they don’t see anything that fits. Taking our example of the student status, someone 

might want to identify themselves first as an international student. 

The process to create a Combo List form control is the same as for a Dropdown List. The 

only change is in the Options tab of the Dropdown List Properties dialog. 

 

For a Combo list ToolTip I would add the information that the user can add their own 

choice if it is not represented. For example, “What is your student status? If you do not see 

it here, type it in.” Another possibility might be “Choose or type your student status.” 

With the ToolTip added, move to the Options tab in the Dropdown List Properties dialog. 

Add the items we did for the Dropdown List example: Full time Student, Part Time Student 

and Continuing Education Student. 

The change we will make in the Options is to check the Check Box “Allow user to enter 

custom text.” This will let someone type over any of existing choices and enter their own 

value./choice 



 

Page 94 of 112 

 

 

Figure 120 Combo List form control with Check Box to allow user input checked. 

When someone comes across this form control they will be able to type over any of the 

choices presented and type their own. This lets them review the choices and simply type in 

one that is not in the list of options. 

 

Figure 121 Combo List form control with user entered data. 

The preceding image shows the Combo List form control with the addition by a person who 

identifies themselves as being an international student as opposed to any of the options 

provided. 
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Digital Signature Form Control 

The last form control we are going to look at is the Digital Signature form control. This is a 

specific form control that lets you use a digital file or certificate to sign a document instead 

of having to print the document and manually signing it. The following image shows the 

Digital Signature tool on the prepare Toolbar. 

 

Figure 122 Digital Signature tool on the Prepare Form Toolbar. 

Once you add a Digital Signature form control to the document, someone cannot type their 

name into the field instead of printing it and signing it. By using a Digital Signature form 

control you commit someone to either using a digital signature file/certificate or printing 

the document and signing it, scanning that page or the entire document back into the 

computer and e-mailing it…or sending it through snail mail/regular post. 

If you don’t use a Digital Signature form control, this might be the process anyway unless 

you create a text box for a signature and indicate on the form that by typing in their name, 

the person filling out the form has “signed” the form. 

Activate the digital Signature tool in the Prepare Form Toolbar. The mouse pointer 

becomes a crosshair and a rectangular area for the form control appears. You know you 

have activated the Digital Signature form control instead of a Text form control because 

there is a red pencil looking item in the upper left of the form control 
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Figure 123 Digital Signature form control in document. 

Click where you want the digital signature to appear in the document and give the form 

control a meaningful name. For this example, I’ve called it DigitalSignature, all one word. 

There are no spaces in the form control names. 

Click on the All Properties link to open the Digital Signature Properties where you can add 

a ToolTip. The ToolTip I used is “ Either digitally sign this form or print it and sign it.” 

Activate the Close button. 

What does using the Digital Signature form control mean to the end user? 

As soon as someone using adaptive technology comes across the digital signature, they are 

told that it is a digital signature and they can click to sign. They cannot type anything into 

this form control/field. 

When the digital signature is activated, a dialog opens where someone can choose which 

type of digital signature they have. Most digital signatures will cost you money because 

they are a commitment to this being your signature and has legal integrity. If you don’t 

have a digital signature or certificate, you can buy one. You don’t have to be an organization 

to purchase a digital signature. This book does not walk you through purchasing a digital 

signature nor will I recommend any specific company. 
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Figure 124 First step in using a digital signature. 

When the person filling out the digital form chooses which type of digital signature or 

certificate they will use, they are taken to the next step where they can locate and point the 

digital signature file. The data is entered into the field and the document is signed. 

 

Figure 125 Second step in using a digital signature. 
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The following image shows the Digital Signature form control in a form. I’ve highlighted the 

small red pencil looking marker that lets you know this is a digital signature form control. 

 

Figure 126 Digital Signature form control showing marker in upper left corner. 

When someone sees this, they know this is a Digital Signature form control and when 

someone using adaptive technology comes across it, they are told that this is a Digital 

Signature form control and to click to digitally sign the form. They can use the keyboard 

alternative to a click to activate the form control. 

Additionally, when a document is opened that requires a digital signature, a dialog opens 

asking the user if they want to automatically install Trusted Certificates. There is a Check 

Box to automatically do this when a form with a digital signature form control is detected. 

 

Figure 127 Trusted Certificates Update dialog. 

An Alternative to a Digital Signature 
Digital Signatures are expensive and not everyone, especially the average person, can 

afford them. How can we make the form accessible in terms of a signature AND provide the 

legal binding contract nature of a signature. 
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One idea is to provide a Check Box indicating that the person has filled out the form to be 

accurate and then to provide a text form control with instructional text and a ToolTip 

indicating that by typing your name, you are legally signing the form. 

 

Figure 128 Alternate to a digitally signed PDF form. 

When I first discussed as an option, workshop participants wanted to make the Check Box 

to confirm that all answers are accurate checked by default. The argument was that this 

would save time in filling out the form. My counter argument is that by making it a form 

control that people must check before submitting the form, by making it a required field, a 

form cannot be submitted without a specific action on the part of the respondent to 

confirm that all of the information is accurate. By also making the form control where you 

type in your name as a signature a required field, you complete the acknowledgement of 

accuracy and signature. Using this method, a form cannot be submitted until the 

respondent confirms accuracy and “signs” the form. 

 

Figure 129 Form controls for alternate signature process. 

This is only one idea on creating a form that can be digitally signed without requiring 

someone to either purchase an expensive digital signature or having to print out the last 

page, sign it, scan it in and then submit it with the form. Someone would have to have 

Acrobat to make the substitution and know how to extract and add pages to the document. 

Since this is a visual/mouse driven activity, many people with visual disabilities would not 

be able to do this independently. The solution offered creates an independent way of 

digitally signing a PDF form. As an aside, most people wouldn’t be able to afford Adobe 

Acrobat Pro DC which means the process of printing and signing forms encounters a huge 

barrier at the start. This solution can be completed in Adobe Reader and removes barriers 

for those of us with disabilities. 
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Adding the Tags to a Form 

When you have all the form controls added and you’ve checked the Tab Order, move to the 

third item in the hierarchy of tasks that of adding the links to the document if there are 

links. 

The Create Links from URL’s tool is found under the Link tool in the Edit PDF Toolbar. 

Make sure that if links in the document are not identified using this tool that you manually 

add them at this point. All links must be added BEFORE you Tag the document/form. 

Once form controls and links are added, you can add the Tags to the document. Our form is 

based on a Word document rather than a scanned image of a form. If a scanned image of a 

form is used to layout the form controls , you must perform the text recognition before 

adding the form controls or links. 

To add the Tags choose the Accessibility tools in the Tools Task Pane to the right of the 

document and then choose Autotag Document.  
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Figure 130 Tags Tree for the sample form. 

The preceding image shows that the Tags for the document have been created correctly, 

however, the <>Form Tag for the first question is in the wrong place. This is typical. Drag it 

to the correct place in the tags Tree and move to the next question/form control to examine 

it for logical reading order. 

I recommend that you do an Accessibility Full Check at this point and ONLY look at the 

Form category to see if there are any problems. Later in this chapter we will look at a 

couple of form errors and how to remediate them. 

If you see form errors, exit the document without saving but noting where the errors are. 

Open the PDF form again and remediate the form controls. 

Save the document, perform an Accessibility Full Check and look to see if the errors are 

gone from the Accessibility Full Check Report. 

Once you have a clean Accessibility Full Check Report for the form controls only, then 

proceed with remediating the rest of the document. 
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Figure 131 Repaired <Form> Tag in the Tags Tree to provide logical reading order. 

You will need to add the title for the document, language for the document and set the 

document title to show in the Title Bar. This is done in the Document Properties dialog 

(Ctrl + D).  

I recommend going to the Pages Panel in the Navigation Pane and adjust the Tab Order so 

that all pages of the form are using the document structure for the Tab Order. While it is 

true that we maintained a Tab Order while in the Prepare Form tools, I find it is just a good 

habit to get into for all documents so that I don’t inadvertently skip this process for 

documents that are not forms. 

The following image shows a list of form controls using the JAWS screen reader in the 

sample document once the Tags have been added and any remediation’s to the logical 

reading order have been made. You can Tab around the form controls using either the 

JAWS screen reader or the NVDA screen reader to check on the Tab Order and make sure 

the ToolTips are being read. 

DO NOT use Read Out Loud to test your form!!!!!!!!!! 
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Figure 132 List of form controls using the JAWS screen reader. 

We can now move on to performing the Accessibility Full Check. 

Accessibility Full Check for Forms 
To perform an Accessibility Full Check on your form created in Adobe Acrobat Pro DC, go to 

the Accessibility tools in the Tools Task Pane and choose Full check. Accept the default 

settings and activate the OK button. The Accessibility Full check Report will open in the 

Navigation panel to the left of the document. 
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Figure 133 Results of an Accessibility Full Check for our form. 

You cannot use the Acrobat Accessibility Full Check for forms you create in Form Designer. 

However, good news! The latest version of Form Designer has an accessibility checker to 

check forms created using this tool. Any remediation’s will need to be done in Form 

Designer. 

Note: The old LiveCycle Designer does not have an accessibility 

checker and you cannot use the accessibility checker in Adobe 

Acrobat Pro to check the accessibility of LiveCycle Designer forms. 

They are separate programs. 

Remediating the Tagged Form 
When you perform an Accessibility Full Check and you get form control errors, it is most 

likely that the form control was not added to the document correctly. In the following 

image, I added a form control to an already tagged document. This resulted in an error for 

both the form control and the fact that I didn’t add the ToolTip. 
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Figure 134 Form errors in an Accessibility Full Check Report. 

If you add form controls and then do an Accessibility Full Check just after you add the Tags, 

you will be able to troubleshoot any mistakes made in adding form controls. You can   then 

exit the document (if there are errors) without saving, open the document again, make the 

repairs to the form controls and Tag the document. Run the Accessibility Full Check again 

and if you have a clean check in the Forms category, continue with remediating the Tags 

Tree. 

The following image is of the question from the sample form on which bus stop you want to 

be picked up at. This is a scenario in which you or your child is going to a summer camp or 

organized activity where you will be picked up at the bus stop nearest to you. 

 

Figure 135 Incorrect logical reading order. 

In the preceding image, the Tags for the question related to the bus stops has been 

mistagged. The question text and “Bus stop A” are tagged as one paragraph. The Form 

control or <Form> Tag is in with another Radio Button of the same group. In this case it is 

under the “Bus stop F” text  

 

Figure 136 New Paragraph Tag added to document. 

I used the technique identified earlier in this book of expanding the Tag and adding a new 

<P> Tag at that point in the Tags Tree.  
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In an update to Adobe Acrobat Pro DC the Tags tend to wander less but they can still end 

up at the bottom of a <Part> or <Sect> Tag and need to be dragged greater distances than 

the technique I recommend. 

Once I have the new <P> Tag added and moved to its logical place in the Tags Tree, I make 

sure it has focus.  

 I select the text “Bus stop A” and then use the Options button in the Tags Panel to Create 

Tag from Selection. Now all I have to do is find the right Radio Button for “Bus stop A” and 

drag that <Form> Tag into this <P> Tag so that someone will read “Bus stop A” followed by 

the Radio Button for that bus stop if they are reading through the form. If they simply get a 

list of form controls or just move to the next Radio Button, they will encounter them in the 

order in which the bus stops are arranged. 

 

Figure 137 Tags Options, Create Tag from Selection. 

In this sample form, I’ve put the Radio Buttons after the text instead of before it. This is 

how I designed the form. When adding Check Boxes or Radio Buttons to forms, remember 

to be consistent. Don’t have some form controls before the label/caption text and some 

after it. Make sure that all form controls follow the same layout. 

The following image shows the remediated answer for “Bus stop A” in the Tags Tree and 

the PDF form. The Radio Button is highlighted to illustrate what you are looking for when 

trying to identify the right Radio Button or form control for the right answer.  
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Figure 138 Bus stop A answer remediated. 

For Radio Buttons, they all have the same name which is the Group name so you really need 

to locate the correct one visually on the page and drag it to where it should be in the Tags 

Tree also known as the logical reading order/document structure. 

 

Figure 139 Text that needs a Paragraph Tag. 

In the preceding image, not only do you have to create the <P> Tag for the text “Bus Stop B” 

but you also have to move it to its logical place in the Tags Tree and then find the <Form> 

Tag associated with it and bring the two together in the one <>P Tag.. 

 

Figure 140 Form Tags that need a <Form> Tag 

In the preceding image, several Radio Buttons from the same group have been put into one 

<>Form Tag. The remediation  for this is to create separate <>Form Tags for each Radio 

Button , move them into their own <>Form  Tag and then move the <>Form Tag to the Tag 

representing the right answer in the form.  When we are finished there will be a <P> Tag  

with the text for the answer appearing first followed by the <Form> Tag containing the 

correct Radio Button 
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Figure 141 <Form> Tags added for each Form control. 

The following image shows the remediated Radio Buttons in the PDF form. Each answer 

has its own <P> Tag that contains the text answer and the <Form> Tag. The <Form> Tag 

contains the “BusStop-OBJR information that is necessary for the form control to work 

properly. 

 

Figure 142 Remediated set of Radio Buttons. 

When we perform an Accessibility Full Check, there should ne no errors as shown in the 

following image. 
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Figure 143 Forms passing the Accessibility Full Check. 
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Extend Features in Adobe Reader 

The last thing you need to do for the form is to turn on the ability for someone to save the 

form and fill it out gradually on their computer. For people with learning, cognitive, visual 

or physical disabilities fatigue might set in if they have to fill in a form all at once. There is 

also the issue of trying to find and remember what information to enter into a form. For 

people with physical disabilities such as tremors , palsy, Multiple Sclerosis, Parkinson’s, 

Huntington’s, or Hodgkin’s disease, having to stay at the computer and fill in a form all at 

once can result in physical fatigue and frustration. 

The other advantage to turning on Reader Extended PDF is that someone can archive their 

form in case they need to resend it or need it for their records. 

 

Figure 144 Save as Reader Extended PDF from File Menu. 

Once a form has passed an Accessibility Full Check, go to the File Menu and choose Save as 

Other. Choose Reader Extended PDF and then choose Enable More Tools (includes form fill 

in and save). The keyboard command is Alt + F, H, D, M. 
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Figure 145 Message letting you know what features are turned on with Reader Extended choice. 

Turning on the ability to save the form on your computer so that you can fill it out 

gradually lets you work with the form when you are refreshed, can see better, can 

concentrate better, can go gather the required information and addresses the barrier of 

having to keep the form open for several hours in order to retain information  

If your form is secure, before you turn on the Reader Extended tools, you need to first allow 

filling in of forms and digital signatures in the security settings. If you forget, you will get a 

message saying that you can’t turn on the Reader Extension tools while there are security 

settings for the document turned on. 

 

Figure 146  Security dialog showing setting for fillable form. 
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If there is no security required for your form you don’t need to do this. People will be able 

to fill in the form digitally but you will need to turn on the Reader Extended features in 

Adobe Reader to give them the opportunity to save it to their computer and fill it out 

gradually. 

 


